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Dragon NaturallySpeaking 12.5 includes updated features and bug fixes. Dragon 12.5 is available for existing customers
as a free service pack downloaded to your computer, and for new customers through a full download or DVD purchase.
The system requirements for 12.5 remain the same as for 12 but with added support for recently released software.
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What's New in 12.5
The Dragon Sidebar is set to “Floating” by default
Previously, the Sidebar was set to “Docked to Right” by default, but in Dragon 12.5 this is changed to “Floating.” This is
meant to avoid disturbing the arrangement of desktop icons that may be located beneath the docking area of the Sidebar.
(As before, by default, the Sidebar opens whenever your profile opens.)
Important: If set to “Floating,” the Sidebar may cover part of your screen. As before, changing this and other Sidebar
settings can be done by right-clicking the Sidebar.: The Sidebar menu that appears allows you to change the font size,
switch to another monitor, print the Sidebar content, hide its Tips pane, and hide its Mouse tab. In addition, the Sidebar
can be made wider or thinner by adjusting the window size.

Updated application support
Note: For the latest details on Dragon functionality with a particular application, please see the Dragon support page and
Knowledgebase on the Nuance website: http://www.nuance.com/support/dragon-naturallyspeaking/index.htm

Support for Microsoft Office 2013
Dragon 12.5 now supports Office 2013 with the same functionality for the same currently supported applications that were
found in earlier versions of Office. For more information, see the product help.
To access the File tab in Office 2013 applications, say the command "Click File Tab". See the product Help for more
details.

Support for Microsoft Internet Explorer 10
Dragon 12.5 now supports Internet Explorer 10 with the same functionality that was found in Internet Explorer 9. For more
information, see the product Help.
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Updated Rich Internet Applications support
Dragon's Rich Internet Application feature enhances Dragon's functionality in selected browser-based applications: in
these applications, it provides Full Text Control as well as commands to access elements found in the main interface of
the web page.
Dragon 12.5 now supports Microsoft’s Outlook.com mail service, in addition to Gmail and Hotmail.
Rich Internet Application (RIA) extensions are available in the following Web browsers:
•

Microsoft Internet Explorer, version 9 or 10, 32-bit only

•

Mozilla Firefox

•

Google Chrome

Important: the makers of Firefox and Chrome frequently release new versions of their browser. For the latest details on
Dragon functionality with a particular application, please see the Technical Support page
(http://www.nuance.com/support/dragon-naturallyspeaking/index.htm) for Dragon on the Nuance website.
If you wish to use the enhanced capabilities provided by the plug-in, check your web browser’s settings to make sure the
plug-in is enabled. For more information, see the product help and the KnowledgeBase article that covers how to enable
the RIA extensions: http://nuance.custhelp.com/app/answers/detail/a_id/6941

Usability in Windows 8
Note: For the latest details on using Dragon in Windows 8, please see the Dragon support page and Knowledgebase on
the Nuance website:
http://www.nuance.com/support/dragon-naturallyspeaking/index.htm
In Windows 8, Microsoft introduced major changes for end-users compared to previous operating systems, but offers an
interface similar to the familiar desktop (minus its Start menu button).
Even though Dragon is designed to be used primarily on the Windows desktop, 12.5 includes a small toolbar, the
Dragon Audio Bar, which lets you use Dragon's microphone button outside the desktop environment..
There are some restrictions on using Dragon outside the desktop environment.
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Installation guidelines
Use the following table to determine how you should proceed:
You are:

Steps:

Installing V12.5 on a computer
that does NOT have a previous
version of Dragon installed

If your computer does NOT already have a previous version of Dragon installed,
simply install V12.5: See Installing Dragon V12.5 for more information.

Installing V12.5 on a computer
that has a previous version of
Dragon already installed:

Uninstalling the previous version of Dragon (10, 11, or 12.0) is not necessary;
Dragon v12.5 will upgrade your User Profiles from v10 or v11 to v12.5 or open
them without upgrading if they are from v12.0.
Note: If you install V12.5 over a previous version of Dragon, your previous
version of Dragon will be uninstalled automatically.
For more information, see Preparing to upgrade
After completing these steps, install Version 12.5. See Installing Dragon V12.5.

Manually loading a User profile
from previous version of Dragon

You can manually load a User Profile from Dragon V10, V11 or 12.0 with V12.5.
This may be needed if your User Profiles are located in a directory or storage
device that is not automatically detected by Dragon or if they are stored on
another machine.
See Manually loading a User profile from previous version of Dragon.

Preparing to upgrade
Who should read this section:
You should follow these instructions if you are installing V12.5 over versions 10 or 11 of Dragon (upgrading directly from
an earlier version (9 or prior) to 12.5 is not possible).
If you are installing over V12.0, please proceed to Installing Dragon V12.5. Dragon V12.5 uses the same User Profiles as
V12 and does not need to upgrade them.

Backup your User Profiles (optional)
It is a good idea to make a backup copy of your User Profiles in case you ever want to re-install the previous version.
When you install Dragon V12.5, the previous version of Dragon will be removed from your computer. When you start
Dragon V12.5 for the first time, the software will prompt you to upgrade your User Profiles to V12.5.
On the machine where a previous version of Dragon is installed (V10, V11 or V12.0):
If you have V11 or V12 installed:

1.
2.
3.
4.
5.
6.

Start Dragon.
From the DragonBar, click the “Profile” menu.
Select “Manage User Profiles”.
Click on the “Advanced” button.
Click on “Export”.
Navigate to the destination folder and click the OK button.

If you have V10:

1. Start Dragon.
2. From the DragonBar, click the “Naturally Speaking” menu.
3. Select “Manage User Profiles”
3

Dragon V12.5 Release Notes

4. Click on the “Advanced” button.
5. Click on “Export”.
6. Navigate to the destination folder and click the OK button.
Notes:
•

Make sure to select a folder that is not under an existing Dragon NaturallySpeaking directory since these
directories may be deleted during the uninstall process.
For example, you can save the files to C:\DNSV11Users.

•

You can back up your user profiles to another directory on your hard drive, a CD or DVD, a removable storage
device (USB thumb drive), or network drive.

•

For more information, please see the following article in the Dragon KnowledgeBase:
http://nuance.custhelp.com/app/answers/detail/a_id/2313

Secure Important Information (optional)
If you purchased a boxed product, make sure you have the original installation CD or DVD and the serial number that
came with your previous version of Dragon. If you cannot find the original installation CD or DVD and the serial number,
please open Dragon, go to Help, click on “About NaturallySpeaking” and take note of the serial number before the
installation of V12.5.
Note: If you do not have the original installation CD or DVD and serial number, you can install V12.5 but you will not be
able to reinstall your previous version of Dragon.

Back up custom words (optional)
It is a good idea to make a backup copy of your custom words in case you ever want to re-install the previous version.
You may have added custom words or phrases to your vocabulary using the Vocabulary Editor or the Add Words from
Word Lists feature. New words also may have been added from the email and document-analysis tools. In addition,
Dragon may have added new words you entered in the process of correcting a misrecognition.
To see if there are custom entries in your vocabulary:
1. From the DragonBar, select Vocabulary > Open Vocabulary Editor
2. Select “Custom words only” from the Display pull down at the bottom of the Vocabulary Editor dialog box.
If you have any custom words, they will display with a plus sign next to the Written form.
To export your custom words:
1. Select Vocabulary>Export custom word and phrase list from the DragonBar. This displays the Export Custom
Words dialog box.
2. You will be prompted to save the custom words to a text (txt) file.
Note: Make sure to save this .txt file in a place you will remember and save a copy to an external source. If you don’t
have any custom words, Dragon will display the following message, “No custom words found in the current vocabulary.”

Back up custom commands (optional)
It is a good idea to make a backup copy of your custom commands in case you ever want to re-install the previous
version. If you did not create any custom commands, you can skip this step.
Custom commands are voice commands that you may have created to enter text and graphics, as well as activate menu
and keystroke commands in any application.
To view your custom commands:
1. From the DragonBar, click Tools>Command Browser.
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2. From the Command Browser, select Script Mode. This displays the context where custom commands are
available, Dragon’s existing commands and any custom commands you may have created. By default, the Global
Commands are displayed.
3. To view a different context, select one from the Grammar list (top left corner).
To back up any custom commands you have created:
1. From the Command Browser, click the Manage button.
2. Click the plus sign (+) to expand the list of commands that appear if needed to find the command(s) you want to
export.
3. Click the check box to the left of any commands you want to export.
4. Click the Export button on the task pane.
Note: Make sure that you save the Commands (.dat or .xml) file in a place you remember and save a copy to an
external source.

Installing Dragon V12.5
If you are installing on a computer that contains a previous version of Dragon, please read Preparing to upgrade before
you begin following the steps below.
To install Dragon:
1. Connect your microphone.
2. Exit any open program. If you’re running an anti-virus program, turn it off until after the installation completes.
3. If you are installing from
•

The DVD, the installation should begin to run immediately. If the installation does not start automatically, use
Windows Explorer to find and double-click setup.exe on the DVD. Click Next to continue.

•

The download, double-click the file NaturallySpeaking.exe: the installation should begin to run immediately
after the installation files are extracted from the archive. Click Next to continue.

4. Install the prerequisite software when prompted.
Dragon Version 12.5 requires that Microsoft .NET Framework runtime software be installed before Dragon:
•

If Microsoft .NET Framework runtime is not found on your system, the installation will prompt you to install it
(if it is detected, the Dragon Installer will skip this step). Click Install to continue.

•

It may be necessary to restart the computer after installing the .NET Framework runtime.

•

Note that if Visual C++ 8.0 or 9.0 runtime is present from a previous installation of Dragon, it will remain
installed; you do not need to uninstall it when working with version 12.5.

5. The Dragon installation should start automatically after the prerequisites complete installing. When prompted, click
Next.
6. Enter the product serial number when prompted.
7. Choose “Typical/Complete or Custom” as your setup type and specify an installation directory

Activating Dragon
The first time you start Dragon, you will be prompted to activate your copy of Dragon. If you skip activation, you can only
start Dragon 5 times. After 5 starts, you must activate Dragon to continue using the program.
To activate Dragon:
1. Start Dragon. This displays the Activation dialog box:
2. Click Activate Now. This displays the Activation Screen
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Click Activate Automatically to automatically activate Dragon. Selecting Activate Automatically requires no further
action from you.
Activating Dragon on a machine without an internet connection.
An internet connection is required to activate Dragon, but it does not have to be the machine that where you are installing
Dragon.
If you do not have an internet connection available on the machine where you are installing Dragon, please do the
following:
1. Launch Dragon to activate.
2. Click "Activate Now > Activate Manually".
3. Verify that the Serial Number was entered correctly including entering 0's (zeros) not the letter O.
4. Note the “Machine Fingerprint” value on the dialog.
5. On a machine where you do have an internet connection, go to the following address:
http://activation.scansoft.com/us
6. Enter in the two pieces of information:
•

Serial Number

•

Machine Fingerprint

7. Verify that the information is entered correctly.
8. Click the "Generate Activation Key" button.
9. Copy and paste the produced activation key into the first cell on the Activation dialog on the machine where you
are installing Dragon. If the number is entered in manually, verify the number in its entirety.
10. Click "OK" to activate the product.

Creating or upgrading a User Profile
If you are installing Dragon V12.5 for the first time, Dragon will guide you through the process of creating a User
Profile.
If you are upgrading from Dragon V10 or V11, the first time you start Dragon V12.5, it detects any User Profiles you
kept from the previous version, as long as they were stored in the default Users directory and starts the User Profile
Upgrade Wizard to guide your through the process.
If your user profiles are located in a directory or storage device that is not automatically detected by Dragon or they are on
another machine (for example, you have an older version of Dragon on one machine and decide to install V12.5 on a
separate machine), then please read the following section, Manually loading a User profile from previous version of
Dragon .
Note: The user upgrade process will leave the old user profile in their original location

Manually loading a User profile from previous version of Dragon
If your user profiles are located in a directory or storage device that is not automatically detected by Dragon or they are on
another machine (for example, you have an older version of Dragon on one machine and decide to install V12.5 on a
separate machine), do the following:
1. If necessary, copy the user profile(s) to the machine where you will use Dragon.
2. Click Start>Dragon NaturallySpeaking 12.5>Dragon NaturallySpeaking Tools>Upgrade User Profiles.

3. On the Select User Profiles to Upgrade page, modify the list of users to include users that you want to upgrade.
You add users to the list by clicking the “Browse to add a profile…” button. After the list contains the users you
want to upgrade.
4. Click Next and choose the location to save the upgraded User Profiles.
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5. Click Next to proceed. You can expect to wait approximately 10 minutes for each user being upgraded.

Known Issues
Here are some known issues that users should be aware of:
After launching Excel from the Windows Desktop, the user can call the Dictation Box after a cell has focus, dictate
and then transfer text as expected.
When using the Excel Web Application, a browser-based spreadsheet, the user must double click into the cell in
order for text to transfer back from the Dictation Box.
Microsoft Office web applications are not supported, so Dragon functionality may not apply in them. For instance, in
the Excel Web App, the Dictation box text does not always transfer. The user must double-click into the cell in order
for content to transfer from the Dictation box.
"Format next word capitalized" Word property setting does not work with the colon ":" Dictating the word "colon"
when the "Format next word capitalized" word property is enabled will not result in the following word being
capitalized as expected.
The Word Properties dialog does not visually retain changes to the "Use Alternate Written Form" settings, although
Dragon follows the new settings. (After the “Alternate Form” word property has been enabled and the changes are
applied, viewing the word properties again will not show the modified Alternate Form. (Please note that the Alternate
Form is still properly configured and the rules will still be followed when dictating that word, but the specific change
may not be displayed in the Word Properties dialog.)
Using the “Post to Twitter” command may return an error and the login page redirects to Nuance.com. Please try
logging into twitter.com and going to the apps section of the account settings and revoke access from Dragon
speech recognition. Once you have made the changes, you should be prompted to log into Twitter the next time you
try to post from Dragon and posting to twitter will work as expected moving forward
Rich Internet Applications (for Gmail, Hotmail and Outlook.com): When using Google Chrome 25, the Rich Internet
Application support extension may be disabled be default, requiring the user to manually enable it.

If the user launches Chrome v25 (beta) with DNS 12.0 running, the browser will announce to the user that 3rd party
extensions have been disabled and gives a link to settings to enable them.

After upgrading to Google Chrome 25 (and higher) you will not be able to use the Dragon NaturallySpeaking Rich
Internet Application Support Extension immediately, as Chrome will disable all extensions automatically.
This means that Dragon will not work with Chrome until you perform the following three steps to enable the Dragon
RIA extension.
To enable the extension:

1. Click on the button with the badge (a tiny green indicator in the upper right-hand corner of Chrome) and a
drop down menu will open.
2. You will see the badge and next to it “New extension added (Dragon NaturallySpeaking Rich Internet
Application Support). Click on it.
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3. A dialog will pop up. Click on the “Enable extension” button.

For more information please see the Chrome blog:
http://blog.chromium.org/2012/12/no-more-silent-extension-installs.html

In Chrome v24, RIA Extensions and plugins are installed silently. The user does not need to do anything to enable
them for use with Dragon.

Reminder: In general, if you wish to have the enhanced capabilities in Gmail, Hotmail or Outllook.com, you should
make sure that the plug-in is enabled in your Web browser.
German only: In the Vocabulary Editor, the Word Properties for ":" (colon) cannot successfully be changed to Initial
cap. No consistent capitalization of 1st word after "Doppelpunkt" (colon), even though it is specified in the
vocabulary (Eigenschaften). The issue with “New paragraph” producing a new line when not followed by a pause
has been fixed. The issue with capitalization after a colon “:” still persists. Changing the word properties doesn’t
stick; adding an alternative form and assigning to it the desired properties does stick. Oddly, properties are then
transferred to the main entry.
In all Rich Internet Application enabled sites and all browsers, the "Paste that" voice command pastes the last
recognition result rather than the content of the clipboard.
In Windows 8, the full-screen programs cannot be launched by voice using Dragon’s “open|start <name>” syntax.
To start them, you can just dictate the app’s name in the Start screen; like typing on the Start screen, this
automatically opens the Search field. Once the name is in the Search field, you can say "press enter").
In Microsoft Outlook appointments, Dragon does not have Full Text Control in the Location field. (This is not specific
to 12.5.)
Dictating in Windows 8 apps: In some Windows 8 apps (with the exception of Internet Explorer 10), it will appear
that you cannot select text by voice. However, Dragon does select the text but does not highlight the selected text.
When you dictate after selecting a piece of text by voice, the selected text is deleted character by character and then
replaced by the text you dictated. In addition, when you dictate over selected text in a Windows 8 app, the new text
is inserted once correctly and then inserted again but in error.
For example:
1. In a Windows 8 app dictate some phrase, for example, “Welcome to general training”;
2. Say “Select general” – the text “general” will not be selected or highlighted.
3. Dictate some word or phrase, for example, “test” – the text from the end to the selected word “general” is deleted
character by character and then replaced with a new dictated word “test” – you will now have “Welcome to test
training”. You will then see the text you dictated deleted character by character again and then improperly
inserted. For example, with the above example, you will end up with “Welcome to testtest training”
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In Windows 8 apps (full-screen programs, meaning not in the Desktop environment), using capitalization commands
on a segment of dictated text doesn’t place the “cursor” (insertion point indicator) in the expected location.
If you dictate some text and then select a segment of it and change its capitalization using one of the commands
"cap that", "uncap that", "all caps that", "lowercase that", the visual indicator of the insertion point will appear at the
end of the dictated text, even though the insertion point actually is where you would expect it: at the end of the
segment whose capitalization you just changed.
For example:
1. Start a new message in Mail, put the insertion point in its body.
2. Dictate "welcome to the team ". Dragon writes "Welcome to the team
3. Say "select welcome". Dragon does not highlight it even though it does select it.
4. Say "all caps that"
Dragon does change 'welcome' to 'WELCOME' but, although you would expect the insertion point to appear at the
end of that word, the insertion point is appears after the last dictated text, i.e.'team' in this case.
If you now dictate something, it will be entered after the word “welcome”.
In the Windows 8’s Mail app, when replying to an email, if you use the commands “page up” or “page down”, a
subsequent noise such as clearing the throat may make the focus “jump” to the top of the message.
There is no issue when doing the same while simply viewing the long message.
In Windows 8 apps (full-screen programs, meaning not in the Desktop environment), there is no Full Text Control.
Consequences include:
a. Using capitalization commands on a segment of dictated text doesn’t place the “cursor” (insertion point
indicator) to the expected location. If you dictate some text and then select a segment of it and change its
capitalization using one of the commands "cap that", "uncap that", "all caps that", "lowercase that", the visual
indicator of the insertion point will appear at the end of the dictated text, even though the insertion point
actually is where you would expect it: at the end of the segment whose capitalization you just changed.
b. When the insertion point is moved and clings to a word, the first or last newly recognized word will cling to
that word. If a user moves the insertion point away from the end of the text and, then dictates some new
text, Dragon will not insert the space required to separate the recognition result from the existing text. As in
previous versions, the user can say “spacebar” to obtain a space.
c.

In Mail, the first letter of the subject field and body of message are lowercase. As in previous versions, the
user can say “cap” or “cap next” before the word that should be capitalized.

In Windows 8 apps the voice command "paste that" has no visible effect if the clipboard contains an image (even
though the text field does support images).
Workaround: say “press control v” or physically press the Ctrl and V keys together.
Windows 8 Mail: First letter of Subject and body of message are lowercase.
When dictating the title or body of a message in the Windows 8 Start screen Mail, the first word is not automatically
capitalized.
The Dragon Voice commands for email search (for example, “search email” do not work in in Windows 8.
There is no search result even if using a manual searching. It's a problem related to Outlook 2013. Please see the
following links:
http://answers.microsoft.com/en-us/office/forum/office_2013_release-outlook/the-search-function-isnt-working-inany-folders-of/14705627-263e-49d8-ac8a-648ea9672965
http://answers.microsoft.com/en-us/office/forum/office_2013_release-outlook/outlook-2013-instant-search-does-notfind-content/5d81d177-d122-4071-b712-a7a5848e5bc7
http://answers.microsoft.com/en-us/office/forum/office_2013_release-outlook/outlook-2013-instant-searchnonfunctional/032171f5-729b-44bd-8f06-e0188857d572
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There are some recommendations about possible settings for Outlook to try to fix this.
English-only issue from Dragon12.0 which remains after installation of the service pack but will be fixed in the full
builds of Dragon12.5: Deleting the Dictation Command "cap" from the Vocabulary does not prevent this command
from interfering with the ability to dictate the word "cap".
1. Launch Dragon and profile
2. Go to Voc. > Open Voc. Editor
3. Select the "Words with spoken form only" in the "Display" drop-down menu
4. Select the line for the Dictation Command "cap" (this is a line with only a spoken form, no written form)
5. Click "Delete"
6. Click "Close"
7. Open DragonPad or Word
8. Say the word "cap" or say a sentence with the word "cap" in it.
End Result - the word "cap" should be spelled out in lower-case.
When using Internet Explorer 10 with the Menu bar visible, the dictation commands "Click Favorites” or “Click Tools”
intermittently “clicks” the icon whose label is "Favorites” or “Tools" instead of the corresponding menu bar item.
German only
For Windows 8 users who wish to use the Dragon Audio Bar: Dragon’s hotkeys (e.g., the plus key on the numeric
keypad) do not work when the Dragon Audio Bar has the focus.
However, if the user gives another window the focus (by clicking on it, for instance), the Dragon hotkeys will again
function.
In Windows 8, the Dragon Audio Bar also appears on the “desktop” environment even if the DragonBar is visible.
The users should move it to a location that works for them.
If you are using Internet Explorer 10 on a 64-bit Windows 8 machine, dictation may not work on some web pages;
for example, a command to click a link, or dictation into a text field.
This may be related to the design of the particular web page and how this page is displayed on this particular
browser.
Note: as always with web pages, Dragon functionality is not available until the page fully loads, which may take time
depending on the complexity of the site.

System Requirements
Core Processor
Minimum
Intel® Pentium® 1 GHz or equivalent AMD processor or 1.66 GHz Atom® processor (SSE2 instruction set required).
Recommended
Intel Pentium 2.2 GHz (dual 1.8 GHz core processor) or equivalent AMD processor. *
Note: Streaming SIMD Extensions (SSE) are not supported.

Processor cache
Minimum: 512 KB
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Recommended: 2 MB

Operating systems and RAM
RAM *
Operating System

32-bit

64-bit

Windows 8

√

Windows 7 (SP1)

Minimum

Recommended

√

2 GB

4 GB

√

√

2 GB

4 GB

Windows Vista (SP2 or higher)

√

√

1 GB

2 GB

Windows XP Home (SP3 or higher)

√

N/A

1 GB

2 GB

Windows XP Professional (SP3 or higher)

√

N/A

1 GB

2 GB

Windows Server 2008 SP2

√

√

2 GB

4 GB

Windows Server 2008 R2 (SP1 or higher)

N/A

√

2 GB

4 GB

Windows Server 2012
Notes

N/A

√

2 GB

4 GB

Windows Vista SP1, Windows XP SP2 and Windows XP 64-bit, Windows Server 2008 SP1, Windows 2000,
Windows 2000 Server, and Windows Server 2003 are not supported and installation is prevented on those
systems.
* If your computer has less than the recommended RAM, Dragon will install but displays a message
recommending that you install additional RAM for optimum performance.

Free hard disk space
•

3.2 GB if installing from the DVD.

•

4 GB minimum for non-English versions.

Note: When installing from a download, Dragon will temporarily require up to three times the amount of hard disk space to
extract the installation files. Once the installation is complete, the temporarily files can be removed from the system.”

Microphone
Nuance-approved noise-canceling headset microphone. For details on Dragon-compatible audio input devices (including
digital recorders and Bluetooth wireless microphones), visit the Hardware Compatibility List on the Dragon Support Web
pages. For Bluetooth wireless microphone support, visit http://support.nuance.com/compatibility.

Sound card
Sound card capable of supporting 22 kHz 16-bit audio recording.

Screen resolution
The following minimum screen resolutions are recommended for optimal display of Dragon on your Windows Desktop:
Type of computer
Desktop
Laptop
Netbook

Minimum Resolution
1024 x 768
1024 x 768
1024 x 600

For Windows Vista, Windows 7, and Windows 8 the maximum recommended display magnification is 150 percent.
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Other requirements
•
•

Microsoft Internet Explorer 7 or higher (free download available at www.microsoft.com) is required to view the
product help.
To use Web application support, Dragon requires Internet Explorer version 9 or 10 (32-bit mode only).

•

The ability to install Microsoft's .NET Framework 4 on your PC. If you use a company-owned computer, make
sure you have the privileges needed to install this Windows component.

•

DVD-ROM drive required for installation.

•

An Internet connection for product activation.

Installation directories
Dragon V12.5 installs to the following default directories:
Windows XP Pro/XP Home:
C:\Program Files\Nuance\NaturallySpeaking12
\Ereg
\Help
\iTutorial
\Program
\Tutorial (optional)
C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking12
\BadUsers
\Custom
\Data
\dataarchive
\RoamingUsers (Note: Pro and Higher only)
\upgrade data
\Users
C:\Documents and Settings\<username>\Application Data\Nuance\NaturallySpeaking12
\Results

Windows Vista/Windows 7/Windows 8
C:\Program Files\Nuance\NaturallySpeaking12
\Ereg
\Help
\itutorial
\Program
\Tutorial (optional)
C:\ProgramData\Nuance\NaturallySpeaking12
\BadUsers
\Custom
\Data
\dataarchive
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\RoamingUsers (Note: Pro and Higher only)
\Upgrade data
\Users
C:\Users\<username>\AppData\Roaming\Nuance\NaturallySpeaking12
\Results
Windows Vista/Windows 7/Windows 8 (64-bit)
C:\Program Files(x86)\Nuance\NaturallySpeaking12
\Ereg
\Help
\itutorial
\Program
\Tutorial (optional)
C:\ProgramData\Nuance\NaturallySpeaking12
\BadUsers
\Custom
\Data
\dataarchive
\RoamingUsers (Note: Pro and Higher only)
\upgrade_data
\Users
C:\Users\<username>\AppData\Roaming\Nuance\NaturallySpeaking12
\Results
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